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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms:

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK+ product:

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Code Generator) for RX together with the CS+ IDE to create a working project for the RSK+ platform. It is
intended for users designing sample code on the RSK+ platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK+ platform. Further details regarding
operating the RX71M microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX71M Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Description Document Title Document No.
Type

User's Manual Describes the technical details of the RSK+RX71M User’'s Manual R20UT3217EG
RSK+ hardware.

Tutorial Provides a guide to setting up RSK+ RSK+RX71M Tutorial Manual R20UT3218EG
environment, running sample code and
debugging programs.

Quick Start Provides simple instructions to setup the RSK+RX71M  Quick  Start R20UT3219EG

Guide RSK+ and run the first sample. Guide

Code Generator Provides a guide to code generation RSK+RX71M Code Generator R20UT3220EG

Tutorial Manual and importing into the CS+ IDE. Tutorial Manual

Schematics Full detail circuit schematics of the RSK+RX71M Schematics R20UT3216EG
RSK+.

Hardware Provides technical details of the RX71M RX71M Group Hardware RO1UHO0493EJ

Manual microcontroller. Manual




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps Bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
DVD Digital Versatile Disc
El Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
Pmod™ This is a Digilent Pmod™ (_:(_)mp_atible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification
PLL Phase-locked Loop
RAM Random Access Memory
ROM Read Only Memory
RSK+ Renesas Starter Kit+
RTC Realtime Clock
SAU Serial Array Unit
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TAU Timer Array Unit
TFT Thin Film Transistor
TPU Timer Pulse Unit
UART Universal Asynchronous Receiver/Transmitter
UsSB Universal Serial Bus
WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.


http://www.digilentinc.com/index.cfm
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LENESANS

RSK+RX71M R20UT3220EG0100
Rev. 1.00
RENESAS STARTER KIT+ Jan 23, 2015

1. Overview

1.1  Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE
code generator plug in to create a working project for the RSK+ platform.

1.2 Features

This RSK+ provides an evaluation of the following features:
« Project Creation with CS+

« Code Generation using the code generator plug in.
« User circuitry such as switches, LEDs and a potentiometer

The RSK+ board contains all the circuitry required for microcontroller operation.

R20UT3220EG0100 Rev. 1.00 ——
Jan 23, 2015 RENESAS



RSK+RX71M 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the code generator plug in for the RX family
together with the CS+ IDE to create a working project for the RSK+ platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the code generator plug in for CS+
e Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:

e ‘DefaultBuild’ is a project with debug support and optimisation level set to two.

e ‘Debug’is a project built with the debugger support included. Optimisation is set to zero.

e ‘Release’is a project with optimised compile options, producing code suitable for release in a product.

Some of the illustrative screenshots in this document will show text in the form RXxxx. These are general
screenshots and are applicable across the whole RX family. In this case, simply substitute RXxxx for RX71M

The tutorial examples in this manual assume that installation procedures described in the RSK+ Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-depth
information.

R20UT3220EG0100 Rev. 1.00 ———
Jan 23, 2015 RENESAS




RSK+RX71M 3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction

In this section the user will be guided through the steps required to create a new C project for the RX71M
MCU, ready to generate peripheral driver code using Code Generator. This project generation step is
necessary to create the MCU-specific project and debug files.

3.2 Creating the Project

To use the program, start CS+:
Windows™ 7 & Vista: Start Menu (Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC (RX,
RH850)

Windows™ 8: From Apps View &, click ‘CS+ for CC (RX,RH850)’ icon

e CS+ will show the Start Page. Use the
‘GO’ button to Create a New Project.

Create New Project

A new project can be created
A new project can also be created by reusing the file configuration registered to an existing project.

Create New Multi-core Proiect

e In the ‘Create Project’ dialog, select | |CresteProject )
‘RX’ from the ‘Microcontroller’ pull-
down Microcontreller: RX |Z|
e In the ‘Using Microcontroller’ list Using microconiraller
control, scroll down to ‘RX71M’ and i (Search microcontraller) Update. .
expand the tree control by clicking ‘+'. | R5F57IMLCKBG 1 750im) ~ | [Product Name:R5F57TMLCKFC L
Select ‘R5F571MLCxFC(176pin)'. W R5F5T1MLCxFE{144pin) On-chip ROM size[KBytes].4096
Ensure that in the ‘Kind of project’ pull- ﬁ Bt iomaon ackagesQPITSBA
down, ‘Empty Application(CC-RX)’ is M R5F571MLCxLC(177pin)
lected :EF{SFSHMLCXLJ['IDDpln]
selected. W R5F571MLCxLK(145pin)
Choose an appropriate name and M ROFS7IMLDXBG(1 76pin) - -
location for the project, then click _ _—
‘Create’. Kind of project: Empty Application(CC-Rx) |Z|
Note: this tutorial assumes the project Project pame: CG_Tutorial
is named and located at the place Place: Ciworkspace (=]

shown opposite.

If the folder entered cannot be found a
‘Question’ dialogue with be displayed;
click 'Yes'.

Mzake the project folder

CwiorkspacelCG_Tutorial\CG_Tutorial mipj
] Pass the file composition of an existing project to the new project
Froject to be passed: Browse. ..

Copy composition files in the diverted project folder to a new project folder.

Create ] [ Cancel ] [ Help

R20UT3220EG0100 Rev. 1.00
Jan 23, 2015

RENESAS Page 9 of 53




RSK+RX71M 3. Board Layout

e CS+ will create the blank project with ﬁ"tﬁt’{?&oﬁa‘l-&?&rﬁé-tﬁmje&“fiee’j'
the standard project tree. A ‘Codg File Edit View Project Build Debug Tool Window Help
Generator’ node may also be shown, if

previously enabled. oo JE@ DD 9 AP E
@FE[R S
Project Tree o x
A
& 3 @ n;ﬂ Code Generator Property
B[B CG Tutorial (Project) i meraie Lie Mo
% RSF571MLCxFC (Microcontroller)
R Cosec Genertor Dsgn Too | Quipt ldr
EI) Pin View File generation control
EE" Peripheral Functions Register files
EE Code Preview tipac ype .
.. A, CC-RX (Build Tool) # (Enwdct ekl
L. RX Simulator (Debug Tool) Pﬁlfa_se -
Eﬁll File \ersion

R20UT3220EG0100 Rev. 1.00 = zENESAS Page 10 of 53
Jan 23, 2015



RSK+RX71M 4.  Code Generation Using the CS+ plug in

4. Code Generation Using the CS+ plug in

4.1 Introduction

Code Generator is a Windows™ GUI tool for generating template ‘C’ source code and project settings for the
RX71M. When using Code Generator, the user is able to configure various MCU features and operating
parameters using intuitive GUI controls, thereby bypassing the need in most cases to refer to sections of the
Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called CG_Tutorial. A fully
completed Tutorial project is contained on the DVD and may be imported into CS+ by following the steps in
the Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Code
Generator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the user is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit
Code Generator to change any MCU operating parameters.

The CG_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK+.

Following a tour of the key user interface features of Code Generator in 84.3, the reader is guided through
each of the peripheral function configuration dialogs in 84.4. In 85, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

4.2 Enabling Code Generator

After installation of CS+, Code Generator must be enabled. This step is only required once, CS+ will
remember this setting on subsequent launches.

From the ‘Tool' pull-down menu select ‘Plug-in Setting...”. On the ‘Additional Function’ tab, click the box next to
the ‘Code Generator/Pin View Plug-in’ option and ensure it is ticked:

Basic Function

Module Name Description

[ .} Code Ganerator Plug-n Plug4n to generate the device driver automatically for VB50, 7BKD, TBKOR, RL78/G12, G13, G1
CodeGawﬁoran\ﬁav Plug-n Plug-in to generate the device driver automatically and to view the device corfiguration for RX,

Click ‘OK’. CS+ needs to restart to enable this selection, select ‘Yes’ from the Question dialogue box.
After restarting, ‘Code Generator (Design Tool)' node will now be shown in the left-hand ‘Project Tree’ window

pane.
Project Tree 1 x B Property
A M@ =
H E:f) 3 ';‘ '3:\] Code Generator Property
(=R f; CG Tutorial (Project 2 Generate File Mode
RSF571MLCxFC (Microcontroller)
Output folder
Pin View File generation control
*l Peripheral Functions Register files
- Code Preview Report type i
4, CC-RX (Build Tool) 4 Product Information
-z, RX Simulator (Debug Tool] .F:l s
o[ File Lt
R20UT3220EG0100 Rev. 1.00 RENESAS Page 11 of 53

Jan 23, 2015



RSK+RX71M 4.  Code Generation Using the CS+ plug in

4.3 Code Generator Tour

This section presents a brief tour of Code Generator. For further details of the Code Generator paradigm and
reference, refer to the Application Leading Tool Common Operations manual (R20UT2663EJ0100).
Application Leading Tool is the stand-alone version of Code Generator and this manual is applicable to the
Code Generator.

In the Project Tree pane, click on the icon next to ‘Code Generator’ node to expand the list.

Expand the ‘Peripheral Functions’ node by clicking on the next to it.

Open the ‘Peripheral Function’ tab by double clicking on the ‘Peripheral Functions’ name.

The CS+ main window will now contain a ‘Peripheral Functions’ tab with the Initial View as show in Figure 4-1.

@ CG_Tutorial - C5+ for CC - [Peripheral Functions] = R
Eile Edit Miew Project Build Debug Tool Window Help
st FHE X E 9 SRR - 7 BR Defaultuild vl GOy My @B B "o o= =] J%
0P8 Q s
Eloeciies ®% N 59 Property | £ Peripheral Functions | B
¢ 083 T 3 on wf 4 K OB s ocm oo e ¢ i D D B s P g el
- %] GenerateCode | % O G = # M EH S LU D2 O DA DD HEO L & FFEFIE GRS
[=-_% CG Tuterial (Project! .l & -
.38 RSFSTIMLCKFC (Microcontroller) | Clock setiing | On-chip debug setting | Block diagram |
“LJ Code Generator (Design Tool) Main clock escillater and RTCMCLK setting
A7 Pin View Operation
g
) %im Peripheral Functions [7] Main dlock oscillatorforoed oscilltion c
i {Clock Generator;
& Voltage Detection Circuit Main clock oscillation source Resonator -
¥ Clock Frequency Accuracy N e 2 W)
% Low Power Consumption _
& Interrupt Contraller Unit Oscillator wait time: 11000 (s)  (Actual value: 11090.908 ps)
W Buses 4 Oscillation stop detection function Disabled -
W’ DMA Controller
W7 Data Transfer Controller PLL circuit setting
W Event Link Controller [T] Operstion
[
VO Ports Main clock oscillator
W' Multi-Function Timer Pulse
% Port Output Enable 3 x1
& General PWM Timer —
&7 16-Bit Timer Pulse Unit —
" Pregrammable Pulse Generz 240
&7 B-Bit Timer
W Compare Match Timer Sub-clock oscillator and RTC (RTCSCLK) setting
W Compare Match Timer W 7] Operation Il
& Rezltime Clock Nirive canacits for low C1
& Watchdog Timer Output ax
¥ Independent Watchdog Tim Tnformat ion(HOZO000Z) - The following plug-inz are nof enabled.,l s
& Serial Communications Intel gewg C:r_\solerplug]md =
& Serial Communications Intel py‘zg,:: Aﬁ:'}:zz: pdi.l?j
Ironbython Console Plug-i
¥ ICBusIntertace Lyonrathon Cansoe Pluging
W Serial Peripheral Interface Update Manager Plug=in,]
&' CRC Calculator o e T Mmcar] it to anahie_thoco ol . g
' 12-Bit A/D Converter _ ||\ Al Messages / i
< | 3 & Output E
F? Fa Fa = [Je= FE F1 Fa |F= Fir n 2
53 DISCONNECT

Figure 4-1 Initial View

Code Generator provides GUI features for configuration of MCU subsystems and peripherals. Once the user
has configured all required MCU subsystems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project.

Navigation to the MCU peripheral configuration screens may be performed by double-clicking the required
function in the Project Tree -> Project Name -> Peripheral Function on the left.

It is also possible to see a preview of the code that will be generated for the current peripheral function
settings by double-clicking the required function in the Project Tree -> Project Name -> Code Preview on the
left.

R20UT3220EG0100 Rev. 1.00 RENESAS Page 12 of 53
Jan 23, 2015



RSK+RX71M 4.  Code Generation Using the CS+ plug in

4.4 Code Generation

In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a UART.

4.4.1 Clock Generator

Figure 4-2 shows a screenshot of Code Generator with the Clock Generator function open. Click on the
‘Clock setting’ sub tab. Configure the system clocks as shown in the figure. In this tutorial we are using the
on board 24 MHz crystal resonator for our main clock oscillation source and the PLL circuit is in operation.
The PLL output is used as the main system clock and the divisors should be set as shown in Figure 4-2.

R20UT3220EG0100 Rev. 1.00 RENESAS Page 13 of 53
Jan 23, 2015



RSK+RX71M 4.  Code Generation Using the CS+ plug in

ay PI'MJ };ﬁ Peripheral Functions™ | (=[]
Bl GeneateCode Z U AEF#HSAHTHOOLDDUDODOSS T THTE L
Clock setting { Block diagram ‘ =
- Main clock oscillator and RTCMCLK setting
Operation
[ Main clock oscillator forced oscillation ar frware
Main clock oscillation source v
Frequency 24 (MHz)
Oscillator wait time 11000 (us) (Actual value: 11030.908 ps)
Oscillation stop detection function Diszbled -
- PLL circuit setting
Operation
PLL clock source Main clock oscillator -
Input frequency division ratio x1 -
Frequency multiplication factor x10.0 -
Frequency 240 (MHz)
- Sub-clock oscillator and RTC (RTCSCLK) setting -
] Operation
Sub-clock oscillator drive capacity | Drive capacity for low CL v ‘
Frequency :32.753 lHz)
Oscillator wait time |2252.73 \ ms)  (Actual value: 2296.182ms
- High speed clock oscillator (HOCO) setting
[] Operation
Frequency [18 «| (MHz
- Low speed clock oscillator (LOCO) setting
Operation =
Frequency 240 kHz)
- WDT-dedicated low-speed clock oscillator (IWDTLOCO) setting
[ Operation
Frequency :123 kHz)
- RTC clock setting
[] Operation
ck source | Sub-clock oscillator - ‘
- System clock setting
Clock source PLL circuit -
System clock (ICLK) x1 - 240 (MHz)
Peripheral module clock (PCLKA) x12 - 1 (MHz)
Peripheral module clock (PCLKB) x 114 - 60 (MHz)
Peripheral module clock for ADC (PCLKC) x 114 - 60 (MHz)
Peripheral module clock for ADC (PCLKD) x1/4 - 60 (MHz)
Extemal bus clock (BCLK) x 14 - 60 {MHz)
FAash IF clock (FCLK) x 114 - 60 (MHz)
USB clock (UCLK) x1/5 - 48 (MHz)
- BCLK pin output setting
["] Operation ] il
Clock outpus | BCLK -|
- SDCLK pin output setting
[7] Operation L4

Figure 4-2 Clock setting tab

Proceed to the next section on Interrupt

R20UT3220EG0100 Rev. 1.00 = zENESAS Page 14 of 53
Jan 23, 2015



RSK+RX71M 4.  Code Generation Using the CS+ plug in

4.4.2 Interrupt Controller Unit

Referring to the RSK+ schematic, SW1 is connected to IRQ5 (P15) and SW2 is connected to IRQ2 (P12).
SW3 is connected to directly to the ADTRGON and will be configured later in 84.4.4. Navigate to the ‘Interrupt
Controller Unit’ node in Code Generator and in the ‘General’ tab, configure these two interrupts as falling edge
triggered as shown in Figure 4-3 below.

I 7% Property £8 Peripheral Functions” =
» @ = s -

o - an BB e e i r 25 O 4 W = = 12 Lk
L.JGenerateCode ,.Qﬁﬁ&ﬁﬁcﬁ;‘w“ﬁiﬁ*&@@%@@g}_ J“{ﬁ&u 5
{ General | Group Interrupts | Interrupt B/A selection ‘ e
- Fast interrupt setting
[7] Fast intemupt termupt source | BSC (BUSERR vect=16) E
- Software interrupt setting
[ Software intemupt oty | Level 15 (highest)
[T Software intemupt 2 Priorit Level 15 (highest)
- NMI setting
[ NMI pin intermupt lid edge | Falling Digital fitter No filter 0
- IRQ0 setting
[7] 1RGO P P30 Digtal fitte Mo filter 0
Low level . Prior [ Level 15 (highest)
-IRQ1 setting
[ 1Ra1 Fin | P31 Digtal fiter | No filter 0
e | Low level - Pricrit Lewvel 15 (highest)
- IRQ2 setting
IRG2 Pin P12 - Digital fiter Mo filter * 0
Valid edge  Falling - Priority ~ Level 15 (highest) -
- IRQ3 setting
[ IrG3 - P33 Digital filte Mo filter 0
Low level Priorit Level 15 (highest)
- IRQ4 setting =
[C] 1RG4 Pin |PB1 ~| Digtalfiter | No filter 0
Low level \ Priorit Level 15 (highest)
- IRQ5 setting
IRG5 Pin P15 - Digital fiter Mo filter -| |0
Valid edge  Falling - Prioity  Level 15 (highest) -

Figure 4-3 Interrupt Functions tab

Navigate to the ‘Group Interrupts’ sub tab and ensure that the ‘Group BLO’ interrupt is selected as shown in
Figure 4-4. The Group BLO interrupt is used for SCI Transmit End Interrupts (TEIl) and Reception Error
Interrupts (ERI) as described in §4.4.5.
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I Property &8 Peripheral Functions™ [=][x]

%] GenerateCode | & O A E # B E E DO DO OO D E L LT T TFE

e
General | Group Interrupts ’ Interrupt B/A selection ‘
- Group BED setting
[ Group BED Pricrity | Level 15 (highest)

|F@|

~Group BLD setting
[¥] Group BLO Priority  Level 15 (highest) -

—Group BL1 setting
7] Group BL1 Priorty | Level 15 (highest)

- Group ALD setting
[ Group ALO Priority | Level 15 (highest)

- Group AL1 setting
[ Group AL1

—
{1

evel 15 (highest)

Figure 4-4 Group Interrupt Functions tab

4.4.3 Compare Match Timer

Navigate to the ‘Compare Match Timer’ node in Code Generator. CMTO will be used as an interval timer for
generation of accurate delays. CMT1 and CMT2 will be used as timers in de-bouncing of switch interrupts.

In the ‘CMTOQ’ sub-tab configure CMTO as shown in Figure 4-5. This timer is configured to generate a High
priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high

accuracy delays required in our application.

| Property 2‘_&! Peripheral Functions™ [~ (]
% GenerateCode | 2 O & E # M E L S D2 DDA DD DO L LT T TGS L

CMTO | cMT1 | cMT2 | CMT3 |
- Compare match timer operation setting
) Unused @ Used

J» W

m

Count clock setting -
@ PCLK/8 © PCLK/32 © PCLK/128 © PCLK/512

- Interval value setting

Irterval value 1 ms v (Actual value: 1)

- Interrupt setting
Enable compare match intermupt (CMID)

Prority Level 10

Figure 4-5 CMTO tab

Navigate to the ‘CMT1’ sub-tab and configure CMT1 as shown in Figure 4-6. This timer is configured to
generate a High priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in

this tutorial.
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Jan 23, 2015



RSK+RX71M 4.  Code Generation Using the CS+ plug in

Property | 4 Peripheral Functions® =
OB OBOO LB T TEIECS]

%] GenerateCode | & [ & &= 4f ¥ 2 2 7 s

cuTo | CMTT:| cuT2 | cmT3 |
- Compare match timer operation setting -

() Unused

m

@ Used

- Count clock setting
© PCLK/B @ PCLK/32 & PCLK/128 ) PCLK/512

- Interval value setting
Interval value

ms = (Actual value: 20)

- Interrupt setting
Enable compare match intemupt {CMI1)

Priority

Level 10

Figure 4-6 CMTL1 tab

Navigate to the ‘CMT2’ sub-tab and configure CMT2 as shown in Figure 4-7. This timer is configured to
generate a High priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in

this tutorial.

| Property E:k! Peripheral Functions™ =

] Genertecode |2 0 SEFBHLHEBOROD DD DO LRI T BT E S

| cMTo | cMT1| CMT2 | T3 |
- Compare match timer operation setting
) Unused @ Used i

21l

| »

- Count clock setting
@ PCLK/B @ PCLK/32 () PCLK/128 @ PCLK/512

~ Interval value setting
»  (Actual value: 200.004267)

Interval value

- Interrupt setting
Enable compare match interrupt {CMI2)
Level 10 -

Priority

Figure 4-7 CMT2 tab

4.4.4 12-bit A/D Converter

Navigate to the '12-bit A/D Converter’ tab in Code Generator. Refer to the screenshot shown in Figure 4-8
and configure the S12ADO0 as shown. We will be using the S12ADO0 in 12-bit one shot mode on the ANOOO
input, which is connected to the RV1 potentiometer output on the RSK+. The conversion start trigger will be

via the pin connected to SW3.

Page 17 of 53
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[ Property Iﬂ Peripheral Functions™ I (%]
— —
Bl GeneteCode | S O S # MAR T HDADDBDDDORLT T T LSLD
S12AD0 | $124D1 | [
[ Selting 1| Setting2 |
-S512AD0 ion setfing
) Unused @ Used
- Operation mode setting
@ Single scan mode ) Group scan mode () Continuous scan mode
- Double trigger mode setting
@ Disable () Enable
- Self is setting
Mode Unused -
| Use VREFHOxD |
| Unused |
| 1 ADCLK E
| Group A without priority -|
Group | Niot restarted or continued due to Group A priority = ‘
- A/D converted value count setfing
) Average mode
- Analog input channel setting
Convert (Group A) (Group B Add/Average AD value Dedicated sample and hold
ANODO ™ B F =
ANOOT [al] |
ANOO2 [F | !
ANOD3 ] O O
ANOO4 B | |
ANODS W O
ANOOG a8 (| al
ANOD7 i 1] O
- Conversion start trigger setting
Conversion start tngger (Group A)
AID conversion start trigger pin -
c: Group &
Compare match with or input capture to MTUD.TGRA -
ADTRGD# pin selection FO7 -
Data registers setfing
A ted ourt 1-time cenversion |
Data placement FTgM:!@m -
Automatic clearing Disable automatic clearing -
Data accuracy 12-bit accuracy -
- Dedicated sample and hold circuit sefting
Input sampling time |8 | 5
~ ANDOD / Self i ion time setting
Input sampling time 3667 (s)  (Actual value: 3.667) 4
- ANDO1 time setting
Input sampiing time |3.667 | (s} (Aciuz
ANDOZ conversion time sefting
k ampling time 13667 | s (Actualval
- ANDOZ time setting
input sampling time |3:667 | = 667
~ANDD4
Inptt =3 |3.667 1 5,
- ANDOS ¢ time setting
sampiing time |3 667 ‘ ps}  {Actual value: 3.667)
fime setfing
plirg time i3 667 _‘ us)  (Actual value: 3.667]
-ANDO7 conversion time setfing
|3887 | s
=6
4083 (s}
[ | s
Level 15 (highest) -
DI0;
Prioriy [Level 15 (highest -
< [ n b

Figure 4-8 A/D Converter tab
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4.45 Serial Communications Interface
Navigate to the ‘Serial Communications Interface’ tab in Code Generator, select the SCI6 sub-tab and apply

the settings shown in Figure 4-9. In the RSK+RX71M SCI6 is used as an SPI master for the Okaya Pmod™
LCD on the PMOD1 connector as shown in the schematic.

| Property | &3 Peripheral Functions™ [= ][]

] GenerateCode = O S & # # & S D O H D QDD HES LT FHEFE Q.i..ﬂ‘f\;‘
scio | scn | sciz | sci3 | sci4 | scis | SCi | sci7 | scii2 | -
Generalsei:tinggi Setting \
-Function setting - =

) Unused

() Asynchronous mode Transmission

() Asynchronous mode (Multi-processor) Transmission

() Clock synchronous mode Transmission

") Smart card interface mode Transmission

) Simple |IC bus

@ Simple SPlbus Master transmit only -
- Pin setting

3 PO1

TXD6/SMOSIE/SSDAG POO -

] 1 | r

Figure 4-9 SCI6 General Setting tab

Select the SCI6 ‘Setting’ sub-tab and configure the SPI Master as illustrated in Figure 4-10. Make sure the
‘Transfer direction setting’ is set to ‘MSB-first’ and the ‘Bit rate’ is set to 1500000. All other settings remain at
their defaults.
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=]

[ Property |£:£ Peripheral Functions®
—

f] GenerteCode | £ I S ¥ WAL SNB0000DDLTISRT THIELSHE

[scio | scit [ sci2 [ scia | sci | scis | scis | sci7 [ scnz | 8-Bit Timer |
‘ General setting ‘ Setting |
- Transfer direction setting
() LSBirst @ MSBHirst
- Data inversion setting A
@ Normal () Inverted T
- Transfer rate setting
Transfer clock Internal clock + P02 -
Bit rate 1500000 - bps) (Actual value: 1500000, Emor : 0%)
] Enable modulation duty comection | 255 ‘
SCKE pin function selection Clock output -
- Clock setting -
Clock delay Clock is not delayed -

[] Enable clock polarty inversion

- Data handling setting

Transmit data handling Data handled in interrupt service routine -
~ Interrupt setting

TXI6 priority Level 15 (highest) -

TEI6, ERIE priority (Group BLO) Levd 15 (highest) i

- Callback function setting
Transmission end

€ m

Figure 4-10 SCI6 SPI Master Setting

Staying in the ‘Serial Communications Interface’ tab in Code Generator, select the SCI7 sub-tab and apply the
settings shown in Figure 4-11. In the RSK+RX71M SCI7 is connected via a Renesas RL78/G1C to provide a

USB virtual COM port as shown in the schematic.

5 Froperty ‘},] Peripheral Functions™ | [=[2¢]
B GenerateCode | 5 D S X # B A A DO OO G DD HC B
I\suo|scn|5{:|2|5c13|scu|5c15|s<:|5ﬂ\scnz =~
¢ General settinggl Setting ] |
- Function setting i
©) Unused 4
@ Asynchronous mode Transmission/reception -
) Asynchronous mode (Multi-processor) | Transmission - \
) Clock synchronous mode | Transmission v \
(7 Smart card inteface mode \'Transrriss‘ron v \
) Simple IIC bus
©) Simple SPIbus [Slave transmitireceive |
- Pin setting
RXD7/SMISO7/SSCL7 P32 -
TAD7/SMOSI7/SSDAT P30 - Il
4| m b
Figure 4-11 SCI7 General Setting tab
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Select the SCI7 ‘Setting’ sub-tab and configure SCI7 as illustrated in Figure 4-12. Make sure the ‘Start bit
edge detection’ is set as ‘Falling edge on RXD7 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings

remain at their defaults.

=i

Y Property 28l Peripheral Functions™

] GenerateCode | 2 O S & ¥ M A LSS DADDADODTOLLT T ETENSKL
| scio | scin | sci2 | sci3 | sci4 | scis | scis | SCI7 | scin2 | =
| General seitmg‘ 53ﬂi"9§|
- Start bit edge detection setting
() Low level on RXD7 pin @ Falling edge on RXD7 pin
- Data length setting
) Ybits @ 8bits () 7bits
- Parity setting
@ None ) Even @ Odd
- Stop bit length setting
@ 1bit © 2bis 2
~ Transfer direction setting
@ LSBirst ) MSBirst
- Transfer rate setting :
Transfer clock Internal clock ~ | P31 |
Bit rate 15200 - bps) (Actual value: 15230.769, Emror: 0.16%)
Enable modulation duty comection (255 |
SCK7 pin function SCKT7 is not used -
- Noise filter setting
[] Enable noise fiter
Noige fiter clock [ Clock signal divided by 1 - | EBGL‘DDL‘[}C' ‘ Hz
- Hardware flow control setting
@ None ® CTS ) RTS
P23 -
_ Data handling setting
Transmit data handling Data handled in interrupt service routine -
Receive data handiing Data handled in interrupt service routine v
- Interrupt setting
TXI7 priority Level 15 (highest) -
RXI7 pricrity Level 15 (highest) -
Enable emor intermupt (ERI7)
TEI7, ERI7 priority (Group BLO) Level 15 (highest)
- Callback function setting
Transmission end Reception end Reception emor
< | 1 | »
Figure 4-12 SCI7 Asynchronous Setting
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4.4.6 I/O Ports

Referring to the RSK+ schematic, LEDO is connected to P03, LED1 is connected to P05, LED2 is connected
to P26 and LED3 is connected to P27. Navigate to the ‘I/O Ports’ tab in Code Generator and configure these
four I/O lines as shown in Figure 4-13 and Figure 4-14 below. Ensure that the ‘Output 1’ tick box is checked.
This ensures that the code is generated to set LEDs initially off.

| % Property %l Peripheral Functions® =

B GenerateCode L J SE ¥ M AELEBDODOODADDDOSRST THEFEMLSL
Portd | Port1 | Por2 | Port3 | Ports | Ports | Ports | Port7 | Port | Ports | Porta | Portg | PortC | PortD | PortE | PortF | PortG | Portd | =
-PO0
@ Unused ©@h® ©ou® [JPuuwp |CMOSoutput T‘ High-drive oLtput
P01 2
@ Unused © In ) Out [] Pullup ]CMDS output - | Output 1 | High-drive output
P02
@ Unused @ h @t © Oou ¥ | Pull-up !CMDS output r [ output 1 [] High-drive output
-P0O3
O Unused ) In @ Out | Pulup  CMOS output - Output 1 High-drive oLtput
- P05
) Unused @ In @ Out [7] Pullup CMOS output - Output 1 [V] High-drive output
-PO7
@ Unused ©Oh't © Ou 2 | Pull-up | CMOS output -| | High-drive output
il 1 *
Figure 4-13 1/O ports — Port0
Property f,_ﬂ Peripheral Functions™ =[]
c@]Generate(lcrde _ﬁgW:ﬁﬁ@@@%@@@Lﬂ@@ffﬂgflﬂ’%@\;
| Portd | Portt | For2 | Pori2 | Ports [ Ports | Porté | Port7 | Ports [ Por9 | Porta | Pore | PoriC | Pord [ Pore | PorF | PortG | Ports | i
-P20
@ Unused © In ) Out || Pullup !CMDS output | Dutput 1 || High-drive output
-P21
@ Unused ® In ©) Out ] Pulup | CMOS output Output 1 High-drive output =
P22
@ Unused O In © Out [] Pulup | CMOS output | ] Output 1 [[] High-drive output
-P23
@ Unused ©in ) Out ] Pull-up iCMDS output - [] Output 1 | High-drive output TN
P24
@ Unused ) In ©) Out [ Pulup | CMOS output v | [ Output ] High-drive output
P25
@ Unused © In ) Out | Pullup [CMDS output v Output 1 | High-drive output
-P26
() Unused ®hn @ Out [ Pullup CMOS output - Output 1
-P27
@) Unused @ In @ Out [] Pull-up CMOS cutput - Output 1 High-drive output
il i »

Figure 4-14 1/O ports — Port2

P45 is used as one of the LCD control lines, together with P46 and P47. Configure these lines as shown in
Figure 4-15.
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| % Property | £ Peripheral Functions® =lod

%] Generate Code | % [ cﬂ"l\_‘;fﬁf#gﬁ;%ﬁ:ﬁ@&@@&@@‘ﬁﬁlé’@f,fﬁtﬁflfﬁ:hdk;
{[ Portd [ Port1 [ Port2 | Port3 | Portd | Ports | Ports | Port7 | Port8 | Portd | Porta | Porte | PortC | FortD | PortE | PortF | PortG [ Ports | e
@Uused ©h@® ©O0uwt® [JPuup |CMOSoutput v| ] Output 1
P41
@ Unused @ In © Out ] Pullup CMOS output v| [ ] Output 1 =
) '
@ Unused @ hn ) Out || Pullup J'CMDS output 1 ‘,‘ [] Output 1
P43
@ Unused ) In @ Out [JPulup [ CMOS output v| ] Outpit 1 =
P44
@ Unused ®h ) Out | Pullup | CMOS output - Output 1
P45
() Unused @I @ Out [ ] Pull-up CMOS output #| Output 1
_P4g
© Uused @ I @ Out | Pllup  CMOS output - Output 1
P47
™) Unused @ In @ Out [ ] Pull-up CMOS output - [] Output 1 I
4 | mn »

Figure 4-15 1/O ports — Port4

Peripheral function configuration is now complete. Save the project using the File -> Save Project menu item,
then click ‘Generate Code’. The Output pane should report ‘The operation of generating file was successful’,
as shown Figure 4-16 below.
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M0403002:The generating source folder is: C: \Wurkspace\CG_Tutnrial\,(J -
M0403001:The £following £files were generated:‘J

M0405000:cg_srohr_cog main.c was generat Ed.cJ

M0405000:cg_srchr_cg_dbsct.c was generated.d

M0403000:zcg_srchr og intprg.c wWas generated_‘J

M0403000:cg_srchr cog resetprg.c was generated.d

M0403000:-eg_srchr_eg _sbrk.c was generat Ed_(J

M0403000:eg_srchr_cg wvecttbl.c was generat Ed_(J
M0403000:-cg_srehr_eg_sbrk.h was generated_(J
M0403000:-eg_srchr_eg_stacksct.h was generated_ij —
M0403000:-cg_srcehr_eg_vect.h was generated_(J
M0405000:cg_srchr_ecg_hardware_setup.c wWas generated_(J
M0405000:-cg_srch\r_cg_macrodriver h was generated_(J
M0405000:cg_srohr_cg_userdefine.h was generated_tj
M0405000:cg_srchr og ogo.c Was generated_cj
M0405000:cg_srohr_cg ogo_user.c wWas generated.d
M0403000:cg_srchr_cg cgc.h was generated_cj
M0403000:cg_srchr_cg icu.c was generated_cj

m

M04053000:-cg_srchr_ecg _icu user.c was generated_d
M04053000:eg_srchr_cg icu.h was generated_(J
M0403000:-cg_srch\r_ecg_port.c was generated_(J
M0403000:-cg_srchr_cg_port_user.c was generated_(J
M0403000:-cg_srcehr_eg_port.h was generated_(J
M0405000:cg_srchr_cog_cmbt.c Was generated_(J

M0405000:cg_srchr_cog cmt_user.c Was generated_ij
M0405000:cg_srehr_cg_cmt.h was generated_d
M0405000:cg_srchr_cg_sci.c was generated_cj
M0405000:cg_srohr_cg sci_user.c was generated.d
M0405000:cg_srehr_cg_sci.h was generated_cj
M0403000:cg_srchr_cg_sliad.c was generated.d
M0403000:eg_srchr_ecg sliad user.c was generated_cj
M0403000:eg_srchr_cg_sliad.h was generated_,[J

MO405%003:The operation of generating file was sur_'r_'essful_,[J
[ECF]

Il Messages: , *Code Generator /{ *Rapid Build f -

Output HE Error Listl

Figure 4-16 Code generator console

Figure 4-17 shows the Code Generator Files in the Project Tree pane. In the next section the CG_Tutorial
project will be completed by adding user code into these files and adding new source files to the project.
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Project Tree o x

5 2| [&
=L 3 CG Tutorial (Project)
------ ﬁ RSF57T1IMLCxFC (Microcontroller)
' ""E;] Code Generator (Design Teol)
------ .. A, CC-RX (Build Tool)
------ .22 RX Simulator (Debug Tool)
5 @ File
E ﬂ Build tocl generated files
R Code Generator
-&-| r_cg_main.c
‘fz] r_cg_dbsct.c
é;] r_cg_intprg.c
‘;l r_cg_resetprg.c
lg r_cq_shrk.c
&;I r_cqg_vecttbl.c
fg r_cg_hardware_setup.c
& r_cq_cgec
& r_cg_cge_user.c
‘g r_cg_icu.c
Q F_Cg_icu_user.c
'-'a r_cg_port.c
& r_cg_port_user.c
&;I r_cg_cmt.c
C-‘*;—] r_cg_cmt_user.c
& r_cq_scic
& r_cg_sci_user.c
g r_cg_sl2ad.c
& r_cg_s12ad_user.c
l_g r_cg_sbrk.h
-.h r_cq_stackscth
-] r_cg_vecth
.| r_cg_macrodriver.h
g r_cg_userdefine.h

E_] r_cg_cgc.h
?:l r_cg_icu.h
EI r_cg_port.h
ﬂ r_cg_cmt.h
‘_‘_] r_cg_scih
i_:j r_cg_sl2ad.h

Figure 4-17 Code Generator Files in the Project Tree
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5. Completing the Tutorial Project

5.1

Project Settings

A, CC-RX Property

e In the ‘Project Tree’' pane, select | > - =
‘CC-RX (Build Tool). The build LR DefautBuid
. . . . 4
properties will appear in the main Instction set archilectuas b2 architecturelsamn2)
. Uzes floating-paint. operation instructions Yes|-fpu)
WIndOW Endian typegfnpr data ’ L\llla—:ndian datal-endian=little)
. . Rounding method for floating-point constant operations round to nearest-raund=nearest)
] CS+ creates a Slngle bulld Handling of denomalized numbers in foating-point constants Handles as zeros|-denormalize=off]
. . ¢ T Precision of the double type and long double type Handles in single precision|-dbl_size=4]
configuration called ‘Default Build Replaces th i pa with e sho ype. .
for the project. This has standard St o hsebe e
imi I Selects the enumeration type size automaticall Mo
COde Optl m IS&tIOﬂ turned on by Order of bit-field members 4 ' Allacates from right{-bit_order=right)
Assumes the boundary alignment value far structure members is 1 No[-unpack)
erault.
Enables C++ exceptional handling function [try, catch and throw)] Mo[-nioexception)
Enables the Ct+ exceptional handing function (dynamic_cast and typeid) Mo tti=off)
General registers used only in fast intermupt functions None{-fint_register=0]
Branch width size Compiles within 24 bits(-branch=24)
Base register for ROM None
Base register for RahM None
Address value of base register that sets the address value 00000000
Register of baze register that sets the address value None
Build mode
Selects the build mode name to be uzed during build,
e Select the ‘Compile Options’ tab at | °“'°" s . £99(1ang-cS8)
. . ariguage of § rce file -lang=c
the bottom of the properties window Lanquage of the Ce+ source fle CiCoSanga)
pane_ Under ‘Language Of the C > Additional include paths C
HPN] ‘ _ f > System include paths pa
source flle SeleCt ng('lang_cgg) > Include files at the head of compiling units Include files at the head of con
as shown opposite_ > Macro definition Macro defirition[0]
Irealidates the oredefined macro
e Select the ‘Link Options’ tab at the | ¢ Optimization y y
b f th ti ind Optimization type Mo optimize[-MOO0Ptimize)
ottom of the properties Window | , section
pane. Under ‘Section -> ROM to Section start address B_1.A_1.B_2A_2B.R5U,5/04 PResetPRG OFFFFB000,C_1.C
i ’ > The specified zection that outputz  The specified section that outputs externally defined symbolz to th
RAM mapped section’, add the Lo spee i 0
. > Sechion alignment echion alignment
three  mappings as  shown RiOM to FM mappe ROM to RAM mapped section[3] =
0pp05|te. [0 D=R
1] D_1=R_1
[2] D=k &
. Thes_e settings are easily added _by Text Edit B
clicking the button *..." and pasting Text
the following text into the dialog: =
D_1=R_1
D_2-R_2
D=R
D 1=R 1
D 2=R 2
e This ensures that the linker assigns
RAM rather than ROM addresses
to C variables.
4 b
0K || Cancsl || e
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=

e From the ‘_BU|Id’ r’nenu_, se‘lect ‘_Bmldl Build Mode Settings @
Mode Settings...’. Click ‘Duplicate
and in the resulting ‘Character Selected buid mode:
String Input’ dialog, enter ‘Debug’ |
for the name of the duplicate build

mode. Build mode list:

e

e The new ‘Debug.’ build mO(_:ie will _be A, CC-RY Propetty E][
added to the Build mode list. Click 2 Build Mode
‘Close’. Now, in the main CC-RX (Buildmode e =
Property window, under the 4 OutputFile Type and Path
‘Common Options’ tab, click on the Output file type
line containing ‘Build Mode’, click Intermediate file output folder

the pull-down arrow and select
‘Debug’ from the pull-down’.

e Inthe ‘Frequently Used Options (for | A comxPropert @ (& =

) s 4 BuildMode
Compile) group, select the Build mode Debug

‘Optimization Level’ option and b CPU

select ‘0O’ from the pull-down. We | | " PIC/FD
4 Output File Type andPath

ha.Ve now CreatEd a ‘Debug, bu"d Output file type Execute Module[Load Module File]
mode W|th no Code Optimisation Intermediate file output folder #Buildd adeM ame?;
. . . 4 Frequently Used Options{for Compie]
and will be using the Build mode to b Addtional include paths Additional include paths[2]
create and debug the project. [+ Syztem include paths System include paths[0]
> Macro definition Macro definition[0]
Outputs debugging information “Y'es[-debug]

Optimization level 0[-optimize=0) El
Outputs additional information for inter-module optimization
Optinization type 1[-optimize=1]
Outputs a zource list file 2[-optimize=2)
4 Frequently Used Dptions{for Assemble] Mz -optimize=rmax)
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5. Completing the Tutorial Project

All of the sample code projects
contained in this RSK are
configured with three Build modes;
‘DefaultBuild’, ‘Debug’ and
‘Release’. ‘Release’ is created in
the same way as above; by
duplicating ‘Default Build'.
‘Release’ build mode leaves code
optimisation  turned on and
removes debug information from
the output file.

To remove debug information from
the ‘Release’ build mode, in the
‘CC-RX Property’ window, select
the ‘Common Options’ tab at the
bottom of the window pane. For
the ‘Outputs debugging information’
option, select ‘No(-nodebug).

Reset the build mode back to
‘Debug’ using the ‘Build Mode’ pull-
down control.

From the menus, select ‘File ->

Save AlI' to save all project
settings.

"\ CC-R Property
4 BuildMode
Build mode
CPU

PIC/PID

4 OutputFile Type andPath
Output file type

Intermediate file output folder
Fi Iy Used Opti

[for Compile]

Additional include paths
Syztem include paths
M acro definition

v vV h

Outputs debugaing infarmation
Optimization level

Outputs additional information for inter-module optimization

Optimization type

Outputs a source list file

F Iy Used Options{for A hle)
Additional include paths

System include paths

Macro definition

Frequently Used Options[for Link)
Using libraries

Outputs debugging information

v T T T R

Outputs debugging information
Selects whether to output debugging information.

@ 2 &l

Debug

Execute ModulelLoad Module File)
*BuildtdodeM ame?

Additional include paths[2]
Syztem include paths[0]

M acro definition[0]
Ho[-nodebug]

Mal-noliztfile]

Additional include paths [0]
System include paths [0]
facro definition [0]

Using libraries[0]
ez [Outputs to the output file][-DEBug)

Thiz comesponds to the -debug and -nodebug options of the compiler.

Additional Folders

Before new source files are added
to the project, we will create two
additional folders in the CS+
Project Tree.

In the Project Tree pane, right-click
the CG_Tutorial project and select
‘Add -> Add New Category’.

Project Tree 1 X

5 Property f_jf Peripheral Functions

'} CG_Tutorial Propetty

Build CG_Tutorial

——

] Properh
pesy.

&2} Dﬁl Code Rebuild CG_Tutoerial
CC-Ry
;: o L4 Clean CG_Tutorial
& | File | M Open Folder with Explorer
p
El Windows Explorer Menu
| Add > \ Rt Add Subproject...
t3| Set CG_Tutorial as Active Project ;ﬂ Add New Subproject..
[I7] Save Project and Development Tools as Package... ) AddFile..
& Paste Ctrl+V 1 Add New File...
#@ Rename F2 \ || Add New Category

Rename the newly-created ‘New
Category’ folder to ‘C Source Files'.
Repeat these steps to create a new
category folder for ‘Dependencies’.

= |} CG Tutorial (Project)*

LAy CC-RX (Build Tool)
g RX Simulator (Debug Tool)
-3 File

Ei--ﬂ- Build tocl generated files
L] jodefineh
4| | Code Generator

N C Source Files

i RSF57T1MLCxFC (Microcantroller)
& :} Code Generator (Design Tool)
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5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK+. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Locate the files ascii.h, r_okaya_lcd.h, ascii.c, and
r_okaya_lcd.c in this folder. Copy these files into the C:\Workspace\CG_ Tutorial folder.

e Right-click on the ‘C Source Files’ | -3 File

in the Project Tree and select ‘Add - 4! E”ic'ldtgﬂ' QE:E’“EE' files
H 1 oce beneratcr
> Add File...". 1 source ties]

e Browse to the files ascii.c, and ..[]) Dependend]  Add 3 Addrie.
r_okaya_lcd.c in the o = :
C:\Workspace\CG_TutoriaI folder % Open Folder with Explorer . 1 Add New File...
and click ‘Add’. =l Windows Explorer Menu 1) Add New Category

e Repeat the above steps to add the & RemovefromProject  Shift-Del
files ascii.h , r_okaya_lcd.h to the I3 Copy Ctrl+C
‘Dependencies’ folder. &l paste Cirl+V

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx_. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Code Generator, if the user needs to subsequently change any of the Code Generator-generated code.

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following #defines in between the user code delimiter comments as shown below.
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/* Start user code for global. Do not edit comment generated here */
#define TRUE @)

#define FALSE ()

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, open the file ‘r_cg_main.c’ by double-clicking on it. Insert #include "r_okaya_lcd.h" in
between the user code delimiter comments as shown below.

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya lcd.h"
/* End user code. Do not edit comment generated here */

Scroll down to the ‘main()’ function and insert the highlighted code as shown below into the beginning of the
user code area of the main() function:

void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the debug LCD */
R_LCD_InitQ);
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)' RSK+RX71M ');
R_LCD_Display(1l, (uint8_t *)" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)
{
/* End user code. Do not edit comment generated here */
3
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5.3.1 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Code Generator in 84.4.5. In
the CS+ Project Tree, open the file ‘r_cg_sci.h’ by double-clicking on it. Insert the following code in the user
code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */
MD_STATUS R_SCI6_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);
/* End user code. Do not edit comment generated here */

Now, open the r_cg_sci_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */
/* Flag used locally to detect transmission complete */

static volatile uint8_t sci6_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmitend call-back function for SCI6:

static void r_sci6_callback_transmitend(void)

/* Start user code. Do not edit comment generated here */
sci6_txdone = TRUE;
/* End user code. Do not edit comment generated here */

}

Now insert the following function in the user code area at the end of the file:

/

* Function Name: R_SCI6_SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments : tx_buf -

* transfer buffer pointer

* t>x_num -

* buffer size

* Return Value : status -

*

MD_OK or MD_ARGERROR

/
MD_STATUS R_SCI6_SPIMasterTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci6_txdone = FALSE;

/* Send the data using the APl */
status = R_SCI6_SPI1_Master_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci6_txdone)

/* Wait */
}

return (status);

N

End of function R_SCI16_SPIMasterTransmit

/

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Code Generator in 84.4.3. Open the file r_cg_cmth
and insert the following code in the user area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT_MsDelay(const uintl6_t millisec);
/* End user code. Do not edit comment generated here */

Open the file r_cg_cmt_user.c and insert the following code in the user area for global at the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8_t one_ms_delay complete = FALSE;
/* End user code. Do not edit comment generated here */

Scroll down to the r_cmt_cmiO_interrupt() function and insert the following line in the user code area:

static void r_cmt_cmiO_interrupt(void)

{
/* Start user code. Do not edit comment generated here */
one_ms_delay_complete = TRUE;
/* End user code. Do not edit comment generated here */
3

Then insert the following function in the user code area at the end of the file:

Function Name: R_CMT_MsDelay

Description : Uses CMTO to wait for a specified number of milliseconds
Arguments : uintlé_t millisecs, number of milliseconds to wait
Return Value : None

X X ok T~

void R_CMT_MsDelay (const uintl6_t millisec)
uintl6é_t ms_count = O;

do
{
R_CMTO_Start();
while (FALSE == one_ms_delay_complete)

{
/* Wait */

(o)

R_CMTO_Stop();
one_ms_delay complete = FALSE;
ms_count++;

3} while (ms_count < millisec);

3
/

End of function R_CMT_MsDelay

/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. The program will display ‘RSK+RX71M
Tutorial Press Any Switch on 3 lines in the LCD display.
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5.4 Switch Code Integration

API functions for user switch control are provided with the RSK+. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Locate the files rskrx71lmdef.h, r_rsk_switch.h and
r_rsk_switch.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder. Import these three
files into the project in the same way as the LCD files.

The switch code uses interrupt code in the files r_cg_icu.h, r_cg_icu.c and r_cg_icu_user.c and timer code in
the files r_cg_cmt.h, r_cg_cmt.c and r_cg_cmt_user.c, as described in §4.4.2 and 84.4.3. It is necessary to
provide additional user code in these files to implement the switch press/release detection and de-bouncing
required by the API functions in r_rsk_switch.c.

54.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_icu.h’ by double-clicking
on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU_IRQ */
uint8_t R_ICU_IRQIsFallingEdge(const uint8_t irg_no);

void R_ICU_IRQSetFallingEdge(const uint8_t irg_no, const uint8_t set_f_edge);
void R_ICU_IRQSetRisingEdge(const uint8_t irg_no, const uint8_t set_r_edge);

/* End user code. Do not edit comment generated here */
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Now, open the r_cg_icu.c file and insert the following code in the user code area at the end of the file:

Function Name: R_ICU_IRQIsFallingEdge

Description : This function returns 1 if the specified ICU_IRQ is set to
falling edge triggered, otherwise O.

Arguments  uint8_t irg_no

Return Value : 1 if falling edge triggered, O if not

o oX X XN

uint8_t R_ICU_IRQIsFallingEdge (const uint8_t irg_no)
{
uint8_t falling_edge_trig = 0xO0;
iT (ICU.IRQCR[irg_no]-BYTE & _04 I1CU_IRQ_EDGE_FALLING)

falling_edge_trig = 1;
3

return falling_edge_trig;

N

End of function R_ICU_IRQIsFallingEdge

Function Name: R_ICU_IRQSetFallingEdge

Description : This function sets/clears the falling edge trigger for the
specified ICU_IRQ.

Arguments : uint8_t irg_no
uint8_t set_f edge, 1 if setting falling edge triggered, O if
clearing

Return Value : None

*ox % ok o XN

/
void R_ICU_IRQSetFallingEdge (const uint8_t irg_no, const uint8_ t set f_edge)

ifT (1 == set_T _edge)
ICU. IRQCR[irg_no].BYTE |= _04 ICU_IRQ_EDGE_FALLING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~ 04 ICU_IRQ EDGE_FALLING;
}

}
/
* End of function R_ICU_IRQSetFallingEdge

Function Name: R_ICU_IRQSetRisingEdge

Description : This function sets/clear the rising edge trigger for the
specified ICU_IRQ.

Arguments  uint8_t irg_no
uint8_t set_r_edge, 1 if setting rising edge triggered, O if
clearing

Return Value : None

ook X X % X F N\

void R_ICU_IRQSetRisingEdge (const uint8_t irg_no, const uint8_t set_r_edge)
if (1 == set_r_edge)
ICU. IRQCR[irg_no].BYTE |= _08_ICU_IRQ EDGE RISING;
}

else

ICU. IRQCR[irg_no].BYTE &= (uint8_t) ~_08_ICU_IRQ_EDGE_RISING;

* NS

End of function R_ICU_IRQSetRisingEdge
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Open the r_cg_icu_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

In the same file insert the following code in the user code area inside the function r_icu_irg2_interrupt ():

/* Switch 2 callback handler */
R_SWITCH_IsrCallback2();

In the same file insert the following code in the user code area inside the function r_icu_irg5_interrupt ():

/* Switch 1 callback handler */
R_SWITCH_IsrCallbackl1();

5.4.2 De-bounce Timer Code

Open the r_cg_cmt_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Defines switch callback functions required by interrupt handlers */
#include "r_rsk_switch.h"

In the same file insert the following code in the user code area inside the function r_cmt_cmil_interrupt ():

/* Stop this timer - we start it again in the de-bounce routines */
R_CMT1_Stop(Q);

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCallback();

In the same file insert the following code in the user code area inside the function r_cmt_cmi2_interrupt ():

/* Stop this timer - we start it again in the de-bounce routines */
R_CMT2_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelsrCal lback();

5.4.3 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In 84.4.4, we configured the ADC to be triggered from the ADTRGO# pin. In this code,
we also perform software triggered A/D conversion from the user switches SW1 and SW2, by reconfiguring
the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_userdefine.h’ by double-
clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */
#define TRUE (¢D)
#define FALSE )

extern volatile uint8_t g_adc_trigger;
/* End user code. Do not edit comment generated here */
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Open the file ‘'r_cg_main.c’ and insert #include "r_rsk_switch.h" in the user code area for include, resulting in
the code shown below:

/* Start user code for include. Do not edit comment generated here */
#include "r_okaya_lcd.h"

#include "r_rsk_switch.h"

/* End user code. Do not edit comment generated here */

Next add the switch module initialization function call highlighted in the user code area inside the main()
function, resulting in the code shown below:

void main(void)

R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH_InitQ);

/* Initialize the debug LCD */
R_LCD_InitQ);

/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSK+RX71M ");

R_LCD Display(1, (uint8_t *)'" Tutorial ");
R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
while (1U)

/* End user code. Do not edit comment generated here */

¥
In the same file, insert the declarations in the user code area for global, resulting in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Prototype declaration for cb_switch _press */
static void cb_switch_press (void);

/* Prototype declaration for get _adc */
static uintl6_t get_adc(void);

/* Prototype declaration for lcd_display_adc */
static void lcd_display adc (const uintl6_t adc_result);

/* Variable for flagging user requested ADC conversion */
volatile uint8_t g_adc_trigger = FALSE;

/* End user code. Do not edit comment generated here */
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Next add the highlighted code below in the user code area inside the main() function and the code inside the

while loop, resulting in the code shown below:

void main(void)

{
R_MAIN_UserlInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_Init();
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init ;
/* Displays the application name on the debug LCD */
R_LCD_Display(0, (uint8_t *)" RSK+RX71M ');
R_LCD_Display(1, (uint8_t *)" Tutorial ");
R_LCD _Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12AD0O_Start();
while (1U)
{
uintlé_t adc_result;
/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
3
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else iIf (TRUE == g_adc_complete)
{
/* Get the result of the A/D conversion */
R_S12AD0_Get_ValueResult(ADCHANNELO, &adc_result);
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Reset the flag */
g_adc_complete = FALSE;
}
/* End user code. Do not edit comment generated here */
3

Then add the definition for the switch call-back, get_adc() and Icd_display_adc() functions in the user code

area for adding at the end of the file, as shown below:

/

* Function Name : cb_switch_press

* Description . Switch press callback function. Sets g_adc_trigger flag.
* Argument > hone

* Return value : none

static void cb_switch_press (void)

/* Check if switch 1 or 2 was pressed */
if (g_switch_flag & (SWITCHPRESS_1 | SWITCHPRESS 2))
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/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch_flag = 0x0;

N

End of function cb_switch_press

Function Name : get_adc

Description : Reads the ADC result, converts it to a string and displays
it on the LCD panel.

Argument > none

Return value : uintl6_t adc value

FoX X O EN

static uintl6_t get _adc (void)

/* A variable to retrieve the adc result */
uintl6_t adc_result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R_S12AD0_Stop();

/* Start a conversion */
R_S12ADO_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g_adc_complete)

/* Wait */
}

/* Stop conversion */
R_S12ADO_SWTriggerStop();

/* Clear ADC flag */
g_adc_complete = FALSE;

R_S12AD0O_Get_ValueResult(ADCHANNELO, &adc_result);
/* Set AD conversion start trigger source back to ADTRGOn pin */

R_S12ADO_Start();

return adc_result;

N

End of function get_adc

Function Name : lcd_display_adc

Description : Converts adc result to a string and displays
it on the LCD panel.

Argument : uintl6_t adc result

Return value : none

FoE X X XN

static void lcd_display_adc (const uintl6_t adc_result)
{

/* Declare a temporary variable */

uint8_t a;

/* Declare temporary character string */
char lcd_buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t)((adc_result & 0Ox0F00) >> 8);

Icd_buffer[6] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)((adc_result & 0x00F0) >> 4);

lcd_buffer[7] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (uint8_t)(adc_result & 0x000F);

Icd_buffer[8] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

R20UT3220EG0100 Rev. 1.00 = zENESAS Page 38 of 53
Jan 23, 2015



RSK+RX71M 5. Completing the Tutorial Project

/* Display the contents of the local string lcd_buffer */
R_LCD_Display(3, (uint8_t *)lcd_buffer);

N

End of function lcd_display_adc

/

Open the file ‘r_cg_s12ad.h’ by double-clicking on it. Insert the following code in the in the user code area for
function, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8_t g_adc_complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R_S12ADO_SWTriggerStart(void);

void R_S12ADO_SWTriggerStop(void);

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_s12ad.c’ by double-clicking on it. Insert the following code in the in the user code area for
adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

Function Name: R_S12ADO_SWTriggerStart

Description : This function starts the ADO converter.
Arguments : None

Return Value : None

o X XN

void R_S12ADO_SWTriggerStart(void)
{
IR(PERIB, INTB129) = 0U;
IEN(PERIB, INTB129) 1U;
ICU.GENBL1.BIT.EN19 = 1U;
S12AD.ADCSR.BIT.ADST = 1U;

3
/
End of function R_S12AD0 SWTriggerStart

Function Name: R_S12ADO_SWTriggerStop

Description : This function stops the ADO converter.
Arguments : None

Return Value : None

o X XN

void R_S12ADO_SWTriggerStop(void)

{
S12AD.ADCSR.BIT.ADST = 0U;
IEN(PERIB, INTB129) = OU;
IR(PERIB, INTB129) = 0U;
ICU.GENBL1.BIT.EN19 = 0U;

3

/

End of function R_S12ADO_SWTriggerStop

/* End user code. Do not edit comment generated here */
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Open the file r_cg_sl12ad_user.c and insert the following code in the in the user code area for global, resulting
in the code shown below:

/* Start user code for global. Do not edit comment generated here */
/* Flag indicates when A/D conversion is complete */

volatile uint8_t g_adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the in the user code area of the r_s12ad0_interrupt () function, resulting in the
code shown below:

static void r_s12ad0_interrupt(void)

/* Start user code. Do not edit comment generated here */
g_adc_complete = TRUE;
/* End user code. Do not edit comment generated here */

}

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the CG_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK+ serial port are provided with the RSK+. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Locate the files r_rsk _debug.h and
r_rsk_debug.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder. Import these two files
into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG_WRITE (R_SCI7_AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_sci.h’ by double-clicking
on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */

MD_STATUS R_SCI6_SPIMasterTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

MD_STATUS R_SCI7_AsyncTransmit(uint8_t * const tx_buf, const uintl6_t tx_num);

/* Character is used to receive key presses from PC terminal */
extern uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
extern volatile uint8_t g_tx flag;

/* End user code. Do not edit comment generated here */

Open the file ‘r_cg_sci_user.c. Insert the following code in the user area for global near the beginning of the
file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8_t g_rx_char;

/* Flag used to control transmission to PC terminal */
volatile uint8_t g_tx_flag = FALSE;

/* Flag used locally to detect transmission complete */
static volatile uint8_t sci6_txdone;
static volatile uint8_t sci7_txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the r_sci7_callback_transmitend()
function:

static void r_sci7_callback_transmitend(void)

{
/* Start user code. Do not edit comment generated here */
sci7_txdone = TRUE;
/* End user code. Do not edit comment generated here */
3
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In the same file, insert the following code in the user code area inside the r_sci7_callback_receiveend()

function:

static void r_sci7_callback_receiveend(void)

{

/* Start user code. Do not edit comment generated here */
/* Check the contents of g_rx _char */
iIf (("c” == g_rx_char) || (°C" == g_rx_char))

g_adc_trigger = TRUE;
by

/* Set up SCI7 receive buffer and callback function again */
R_SC17_Serial_Receive((uint8_t *)&g_rx_char, 1);

/* End user code. Do not edit comment generated here */

}

At the end of the file, in the user code area for adding, add the following function definition:

Function Name: R_SCI17_AsyncTransmit
Description : This function sends SCI7 data and waits for the transmit end flag.
Arguments - tx_buf -

transfer buffer pointer

t>x_num -

buffer size
Return Value : status -

MD_OK or MD_ARGERROR

ok X X X X Ok XN\

/
MD_STATUS R_SCI17_AsyncTransmit (uint8_t * const tx_buf, const uintl6_t tx_num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
sci7_txdone = FALSE;

/* Send the data using the APl */
status = R_SCI17_Serial_Send(tx_buf, tx_num);

/* Wait for the transmit end flag */
while (FALSE == sci7_txdone)

/* Wait */

return (status);

}

/
* End of function R_SCI7_AsyncTransmit
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5.6.2 Main UART code

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "r_rsk_debug.h"
Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for uart_display_adc */
static void uart_display adc(const uint8_t adc_count, const uintl6_t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCal lback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSK+RX71M ");
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Start the A/D converter */
R_S12ADO_Start();
/* Set up SCI7 receive buffer and callback function */
R_SC17_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI7 operations */
R_SC17_Start();
while (1U)
{
/* Wait for user requested A/D conversion flag to be set */
ifT (TRUE == g_adc_trigger)
uintl6é_t adc_result;
/* Call the function to perform an A/D conversion */
adc_result = get_adc();
/* Display the result on the LCD */
Icd_display_adc(adc_result);
/* Increment the adc_count */
if (16 == ++adc_count)
{
adc_count = 0;
}
/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);
/* Reset the flag */
g_adc_trigger = FALSE;
3
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/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{

/* Get the result of the A/D conversion */
R_S12AD0O_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count */
if (16 == ++adc_count)
{

}

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

adc_count = 0;

/* Reset the flag */
g_adc_complete = FALSE;
3

/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/

* Function Name : uart_display_adc

* Description : Converts adc result to a string and sends it to the UARTL.
* Argument : uint8_t : adc_count

* uintl6_t: adc result

* Return value : none

/
static void uart_display_adc (const uint8_t adc_count, const uintl6_t adc_result)
{

/* Declare a temporary variable */

char a;

/* Declare temporary character string */
static char uart_buffer[] = "ADC xH Value: xxxH\r\n';

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char)(adc_count & 0x000F);

uart_buffer[4] = (char)((a < Ox0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0x0F00) >> 8);

uart_buffer[14] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)((adc_result & 0Ox00F0) >> 4);

uart_buffer[15] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

a = (char)(adc_result & 0x000F);

uart_buffer[16] = (char)((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R_DEBUG_Print(uart_buffer);

}

/
* End of function uart_display_adc

/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.
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The project may now be run using the debugger as described in 86. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK+ has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appear under 'Port (COM & LPT)'
as 'RSK USB Serial Port (COMXx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI7 (see §4.4.5).
When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC
terminal program via the via SCI7. Return to this point in the CG_Tutorial to add the LED user code.

5.7 LED Code Integration

Open the file ‘r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

#include "'rskrx7lmdef.h"

Add the following declaration to the user code area for global near the top of the file:

/* Prototype declaration for led_display_count */
static void led_display_count(const uint8_t count);

Add the following highlighted code to the user code area in the main function:

void main(void)

{
R_MAIN_UseriInit(Q);
/* Start user code. Do not edit comment generated here */
/* Initialize the switch module */
R_SWITCH_InitQ);
/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);
/* Initialize the debug LCD */
R_LCD_Init Q;
/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8_t *)" RSK+RX71M ');
R_LCD Display(1, (uint8_t *)" Tutorial ");
R_LCD Display(2, (uint8_t *)" Press Any Switch ");
/* Sart the A/D converter */
R_S12AD0O_Start();
/* Set up SCI7 receive buffer and callback function */
R_SC17_Serial_Receive((uint8_t *)&g_rx_char, 1);
/* Enable SCI7 operations */
R_SCI17_Start();
while (1U)
{
uintl6_t adc_result;
/* Wait for user requested A/D conversion flag to be set(SW1 or Sw2) */
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get_adc(Q);
/* Display the result on the LCD */
lcd_display_adc(adc_result);
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/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{

adc_count = 0;
led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_trigger = FALSE;

by

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */

else if (TRUE == g_adc_complete)

{

/* Get the result of the A/D conversion */
R_S12AD0O_Get_ValueResult(ADCHANNELO, &adc_result);

/* Display the result on the LCD */
Icd_display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */
if (16 == ++adc_count)
{

adc_count = 0;
led_display_count(adc_count);

/* Send the result to the UART */
uart_display_adc(adc_count, adc_result);

/* Reset the flag */
g_adc_complete = FALSE;

¥
3 )
/* End user code. Do not edit comment generated here */

}

Then, add the following function definition in the user code area at the end of the file:

/
* Function Name : led_display_count
* Description : Converts count to binary and displays on 4 LEDSO-3
* Argument : uint8_t count
* Return value : none
/
static void led_display_count (const uint8_t count)
{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (count & 0x01) ? LED_ON : LED_OFF;
LED1 = (count & 0x02) ? LED_ON : LED_OFF;
LED2 = (count & 0x04) ? LED_ON : LED_OFF;
LED3 = (count & 0x08) ? LED_ON : LED_OFF;
ks
/
* End of function led_display_count
/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in 86. The code will perform the same but now

the LEDs will display the adc_count in binary form.
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6. Debugging the Project

e Inthe ‘Projgct Tree’ pane, right-click Ew---hﬁ CG Tutorial (Proiect}"' |- Internal ROM/RAM
the ‘RX Simulator (Debug Tool)'. % R5F571MLCxFC (Microcontroller) e alinternnl ROMIKDUES!
Select ‘Using Debug Tool -> RX E\ P':J Code Generator (Design Tool) Size of internal RAM[KBytes]
E1(JTAG). ‘.. Ay, CC-RX (Build Tool) 4 Endian
WS RX Simulator (Def=T=2t g LT
E\ji File Using Debug Teol  » | RX E1(Serial)
-T2 Build tool gerl ) property ‘ RX EL(JTAG)
h-| iodefine.h
I ‘—7!‘ I: ) ':e . ||| b P RX E20(Serial)

e Double-click ‘RX E1(JTAG) (Debug | |5 RxE1(JTAG) Property

Tool)’ tp display the‘ debu’gger tool 4 Internal ROMRAM
properties. Under ‘Clock’, change

; Size of internal ROM[KBytes] 4036
the main clock frequency to 24 ;f:“ ::!rifrrj:E?L [L::f:_ﬁ: 552
MHz and operating frequency to s [I —____ =
240MHz. Size of DataFlash men i_'r','[F‘.El}’tt:r_ o4
. . 4 Clock
e All other settings can remain at Main clock source EXTAL
their defaults. Main clock frequency[MHz] 24.0000
Operating frequency[MHz] 240.0000

Allow changing of the clock source on wri No

4 Connection with Emulator

4 Connection with Target Board
Power target from the emulator.(MAX 2001 Mo
Communications method JTAG

JTAG clock[MHz] 16.5

e Connect the E1 to the PC and the
RSK+ E1 connector. Connect the
+5V PSU to the PWR connector on
the RSK+. Connect the Okaya
Pmod LCD to the PMOD1
connector.

e From the ‘Debug’ menu select
‘Download’ to start the debug
session and download code to the
target.
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7. Running the Code Generator Tutorial

7.1 Running the Tutorial

Click the ‘Go’ button or press F5 to begin the program from the current program counter
position. It is recommended that you run through the program once first, and then continue to
the Tutorial manual to review the code.

Once the program has been downloaded onto the RSK+ device, the program can be executed. @
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8. Additional Information

Technical Support

For details on how to use CS+, refer to the
help file by opening CS+, then selecting Help
> Help Contents from the menu bar.

sol Window | Help

Help

@

@+ Open Help for Start Panel

@q‘q One Point Advice...

Ll

2]
=

UEK

|E 3

Tutorial
Learn

About...

Browse Renesas Electronics Microcontrollers Web

Detail Version Information...

F1

For information about the RX71M group microcontroller refer to the RX71M Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.

Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:

http://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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